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(ABSTRACT) 

A preprocessor for the analysis of space frame structures is developed. The preprocessor 

is designed to run in the Microsoft Windows graphical environment which is widely 

available on personal computers. The program is written in the Visual Basic programming 

language. 

Visual Basic is an object-oriented programming language which provides a powerful way 

to create applications for the Windows environment. It is an ideal programming language 

for developing small or medium size Windows applications. 

The basic features of the preprocessor include the ability to read and write data files, entry 

and review of structural data, and a context sensitive on-line help system. In addition, the 

program provides a user friendly interface and adopts standard Windows user interface 

guidelines. A sophisticated automatic data checking mechanism reduces data entry errors 

to a minimum. The preprocessor also features three dimensional graphics which can 

display the structural geometry and applied loads. 
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Introduction 

CHAPTER ONE 

INTRODUCTION 

1.1 COMPUTING ENVIRONMENT 

Computers have been used in structural analysis since the mid-1950s. Their potential for 

carrying out the more laborious analysis tasks was quickly appreciated. There has been 

steady development of methods designed to utilize the speed and numerical processing 

capabilities of computers. During the past four decades, there have been tremendous 

enhancements in both hardware and software. In recent years, computers have become a 

part of daily life. The widespread availability of computers, particular personal computers, 

which appeared only ten years ago, now enables most structural analysis tasks to be 

carried out by machines. Personal computer based structural analysis programs are well 

suited for the analysis of small and medium size structural models. Also, PC based 

programs are ideal for introducing the basic concepts of computer structural analysis to 

beginners because they are easy to understand and easy to use compared to large 

commercial programs developed for mainframes and minicomputers. Another advantage 

of using PC based structural analysis software is the cost efficiency. 

A typical structural analysis program consists of three components: a preprocessor, a 

processor and a post processor. Through the preprocessor, the user enters information 

that describes the geometry of the structure. This information includes joint coordinates, 

member incidences, geometric properties, material properties and applied loads. This 

information is typically saved in a data file. The processor reads this data file and performs 

the analysis to determine the response of the structure to the applied loads. The results of 

the analysis include support reactions, joint displacements and member end forces. The 

processor writes the results of the analysis to an output data file. This output data file is 
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Introduction 

used by the post processor to display the results either graphically or in tabular form so 

that they are easy to understand. 

When performing the analysis of a structure, considerable effort is required in entering the 

computer model of the structure. A large amount of information such as joint coordinates, 

member incidences, geometric properties, material properties and loading has to be 

entered. Most programs for analyzing structures employ a character-based user interface. 

Input to these programs is typically through an input file consisting of a series of 

instructions to the analysis program. This input file is a text file. It consists of a series of 

commands and normally is created by using a text editor. Considerable effort is required 

in creating this file. The user has to memorize the syntax for each command. Also, since 

there is no visual feed back, the potential for making errors is very high. 

The preprocessor described in this report takes advantage of the Windows graphical user 

interface and provides an easy user-friendly environment for creating this input file. The 

preprocessor is entirely menu driven and has extensive on-line help so the user does not 

have to spend time reading through a user's manual for the correct syntax. The program is 

developed as an event-driven program which means that the user is in complete control of 

the order of tasks that are to be performed, instead of the program dictating the order of 

operations to user. The program also has error checking capabilities for reducing data 

entry errors and displays the structure graphically. 

Because Windows provides a series of common user access procedures, the preprocessor 

is very easy to use. All Windows programs make use of a common user interface such as 

drop down menus, dialog boxes, radio buttons and command buttons which reduces the 

learning curve enormously. 
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From a programmer's viewpoint, Windows programs are very difficult to develop. Until 

recently, programming for Windows was a very tedious time consuming task and required 

writing many lines of code using a procedural language such as C. Because Windows is a 

message driven system, tremendous effort was required to develop applications that 

contain many dialog boxes in that the application had to respond to numerous messages. 

Also, the learning curve for Windows program development was very steep. It would 

take months for the programmer to read and understand all the intricacies of Windows 

programming. 

Microsoft Visual Basic provides a good solution to the enormity of Windows 

programming. With Visual Basic, the programmer can create Windows resources with just 

a click of a mouse. Visual Basic allows the programmer to focus on the function of the 

program without having to worry too much about the actual coding. 

1.2 OBJECTIVE 

The objective of the project was to develop a user-friendly preprocessor for the analysis of 

space frames in the Microsoft Windows Environment. The preprocessor creates a data file 

with a format accepted by a three-dimensional structural analysis program that is currently 

under development. (Slobodan and Rojiani, 1993) The preprocessor can also be used as a 

valuable teaching tool for introducing the basic concepts of computer analysis of 

structures to beginners. 

1.3 PREPROCESSOR FEATURES 

The preprocessor is a Windows based application that serves as a front end to a three

dimensional structural analysis program. The preprocessor has the following features: 

• Standard Windows controls are adopted. 
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• All data entry forms can be accessed by logical path at run time. 

• A data checking mechanism verifies the accuracy of the data automatically before it is 

saved to a data file. 

• Three-dimensional graphics output for viewing the geometry of the structure. 

• Capabilities for quickly reviewing input data. 

• Provision for both English and SI units. 

• Automatic generation of member incidences and joint coordinates. 

• On-line help for all the controls and data entry forms used in the preprocessor 

• The preprocessor can be used to create a new model or modify an existing model. 

L40VERVIEW 

Chapter 2 contains an introduction to the Visual Basic programming environment. It also 

presents a brief history of the BASIC programming language. Chapter 3 provides a 

detailed description of the structure of the preprocessor. It also provides an explanation of 

all the menu items and dialog boxes (also called forms). Chapter 4 summarizes the 

capabilities and limitations of the preprocessor. It also contains suggestion for future 

modification to the preprocessor. The user's manual in Appendix A provides additional 

information on using the preprocessor. It presents an explanation of basic Windows 

controls and describes all of the data entry forms. It also provides a tutorial on the use of 

the preprocessor and the steps needed for entering data in the various dialog boxes. 

Appendix B contains a listing of the contents of the data files produced by the 

preprocessor for four types of structures, a plane truss, a space truss, a plane frame and a 

space frame. An explanation of the format of the output data file that is created by the 

preprocessor is also provided in Appendix B. 
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CHAPTER TWO 

THE VISUAL BASIC PROGRAMMING LANGUAGE 

2.1 A BRIEF HISTORY OF BASIC 

The BASIC programming language was created in 1963 by Professor John Kemeny and 

Thomas Kurtz at Dartmouth College. It was designed for the purpose of teaching the 

concepts of programming. It was an excellent computer language for beginners because it 

was easy to understand and follow. However, because BASIC was an interpreted 

language, rather than a compiled language, it was slow and inefficient for application 

development. 

In the mid-1970s, GW-BASIC was introduced by Microsoft. It was an excellent tool for 

performing simple tasks. However, it was slow because it was an interpreted language. 

Also, the source code had to be provided to run the program. No professional software 

developer would consider writing marketable software in BASIC. 

In 1982, Microsoft developed the QuickBasic programmmg language. QuickBasic 

transformed BASIC into a serious development language for the MS-DOS environment. It 

combined the power and speed of a compiled language, with the interactive, productive 

nature of interpreted BASIC. Microsoft added a number of features to the language, such 

as local variables, true subroutine calls, multiline functions, support for modules, all of 

which are essential for developing modular well-structured programs. 

With the introduction of Windows 3. ° in 1990, Microsoft provided a powerful, user 

friendly graphical environment where all programs have a similar interface. Visual Basic 

takes advantage of the features provided by both Windows and QuickBasic. Visual Basic 

is a giant revolution in the way one develops programs. 
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QuickBasic and Visual Basic programs can be run interactively in interpreted mode, or 

compiled into stand-alone executable programs. 

2.2 WHAT IS VISUAL BASIC? 

Visual Basic is an object-oriented programming environment specially designed for 

creating applications for the Microsoft Windows environment. Visual Basic provides an 

easy way for programmers to develop Windows applications using interface objects such 

as command buttons, radio buttons, check boxes, pull down menus, scroll bars and list 

boxes. 

A Visual Basic application is developed by creating one or more forms and placing the 

various interface elements on these forms. The developer then writes subroutines to handle 

the various events that relate to the particular interface object. For example, if a command 

button is pressed, then the developer may want to write a subroutine to respond to this 

event. Visual Basic defines a series of default subroutines that correspond to each type of 

control. 

Visual Basic offers a toolbox window for the programmer to select controls and place 

them in a form. Details of the controls in the tool kit are given in Appendix A. The tool kit 

includes the following items: (see Figure 2.1) 

• Label 

• Frame 

• Check box 

• Combo box 

• Horizontal scroll bar 

• Timer 

• Directory list box 
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• 
• 
• 
• 
• 
• 
• 
• 

Picture box 

Text box 

Command button 

Option button 

List box 

Vertical scroll bar 

Drive list box 

File list box 

: : Label --T exlual label 

:: Frame ---
Fralnel -------., 

Check1 
: : Check Boxes 

: : Combo Box --1'E dilable Combo B ox I 
: : Horizontal :::................ 

: : SCIOli Bar ... 

: : Director" Li;t 
: : Box 

. : : . : : : : : : : : : : ~ 

....-----...., ...................... . 
~ . ~ ...... Picture Box :::: 

'---------' . .. . ................ . 

. . . . . . . . . . . . . . . . . . . . . . . . . . File list D ox :::: 

..................... "' .................... "',. .............................. ,. ............ . 

Fig. 2.1 The standard Visual Basic toolbox 

The controls in the toolbox window can be simply selected and dragged to the desired 

position on the form. The controls can also be resized. Each control in a form has its own 

properties. For example, a property could be a control name, font name or font size, etc. 
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The toolbox saves considerable programming time and allows the programmer to create 

professional looking forms. 

Visual Basic retains most of the advanced features of QuickBasic and has many 

enhancements for developing Windows applications. One enhancement over QuickBasic is 

the manner in which variables are scoped in Visual Basic. A Visual Basic program consists 

of a project which in tum consists of a global module and at least one form module. The 

project can also contain general modules containing subroutines that can be called from 

anywhere in the program. 

The global module declares global variables and constants used in the project. The global 

variables and constants are accessible from any form or module in the project. There is no 

executable code in the global module. Variables and constants declared in the general 

declarations section of a form or general module are accessible from any subroutine or 

function in that form or module. Any variable or subroutine call in a form or module is 

local to that form or module. Figure 2.2 gives an example of the scope of variables (Craig, 

1990). 

In the example shown in Figure 2.2, the program starts to execute the ForlNext statement 

when the form is loaded. Then it prints 0, 37.699116 6 when the mouse is clicked on the 

form. It is obvious that the global declared constant PI and variable Total exist anywhere 

in form1, the local declared constant TWOPI and local variable SubTotal exist only in the 

form, and the undeclared I and PiTotal exist only in Form_Load subroutine. 
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- The Project 

r- Global module 

Global Canst PI = 3.141593 

Global Total As Integer 

r- Form 1 - General Declarations 

Const TWOPI = PI + PI 

Dim SubTotal as Double 

.- Form 1 - Runs when program starts -
Sub Form_Load ( ) 

For I = 1 To TWOPI 

PiT otal = PiT otal + PI 

SubTotal SubTotal + TWOPI 

Total = Total + 1 

Next I 

End Sub 

- Form 1 - Runs when mouse is clicked -
Sub Form_Click 

Print PiTotal; SubTotal; Total 

End Sub 

Fig. 2.2 Example of scope of variables in Visual Basic 

Another enhancement is that a Visual Basic program is event driven. When viewed from 

the outside, a form contains a series of controls such as text boxes, labels, radio buttons or 

command buttons. These controls are designed for entering text, displaying information, 

making multiple choices or executing certain kinds of functions. When viewed from the 

inside, each control within a form has a unique control name and several subroutines that 

are associated with the control. Each subroutine within the form is specified by a control 

name and an event. For example, a button control called OKbutton would have a 

subroutine named OKbutton _ Click( ) that is associated with the control OKbutton and 

that responds to the event that takes place when the button is pressed. 
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As a second example, consider the Open File form shown in Figure 2.3. The Open File 

form has a file list box which displays the file names to be opened. This control has a 

number of events associated with it. These include the following events: 

• Click 

• Double click 

• Gotfocus 

• Keydown 

• Keypress 

After accessing the File Open form, a file can be opened in two ways. The user can select 

the file name by clicking on it in the file list box and then clicking on the OK button, or the 

user can simply double click on the file name in the file list box. For this example, the 

programmer only needs to write three separate subroutines, called File 1_ Click( ), 

Commandl_Click( ) and Filel_DbIClick( ) (Filel is the default control name for the file 

list box, Command 1 is the default control name for the first command button in the form. 

Click and DblClick are the associated events.) When the event Filel_Click occurs, the 

subroutine Filel_ Click( ) is called and the name of the file that has been selected is shown 

in the text box designed to display the file name. The subroutine Command 1_ Click( ) is 

called when the OK button is clicked. This subroutine then opens the file. When the user 

double clicks on the file name in the file list box, the subroutine File 1_ DblClick( ) is called. 

This subroutine places the name of the file in the text box and then opens the file. 
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File Name: 

Files: 
lestl.dal 
test2.dal 
lesl3.dal 
test4.dal 

lamu 
a:\dala 

Directories: 
Il::7 a:\ 
.~F.'. 

Fig. 2.3 Open File form 

Drives: 

IEJa: II 

In summary, each user interface element has a series of events associated with it. The 

programmer writes a series of subroutines that respond to these events. Also, all 

executable code in Visual Basic exists within a subroutine or function block. This is ideal 

for the development of event-driven programs. 

Visual Basic also supports the exchange of data with other applications and the 

establishment of links with other applications. It also provides support for custom routines 

written in another programming language. 
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3.1 INTRODUCTION 

CHAPTER THREE 

PREPROCESSOR 

In this chapter a description of the preprocessor is presented. The important features of 

the preprocessor are described. A description of the input data required to generate a 

structural model and the various coordinate systems are also given. This chapter also 

describes the structure of the preprocessor and the forms (or dialog boxes) that the 

processor provides for entering structural data. 

The main components of the preprocessor are: 

a) File processing, b) Data entry forms, c) Data review with graphics and d) On-line help. 

The main form of the preprocessor is shown in Figure 3.1 

file .structure .units Member Joint Loads ~iew Option Help 

Fig 3.1 Main form of the preprocessor 
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The file processing functions handle all options related to reading and writing files. The 

file menu provides options for creating new files, opening an existing file and saving and 

renaming files. All of these functions follow the standard Windows format for file 

operations. 

Data entry forms are used to create the structural model. All of the forms related to data 

entry are provided with standard command buttons such as OK and Cancel buttons. 

The data review forms provide an easy way to check the data. There is both graphical 

output and text output. The graphical output displays the structure geometry, joint 

number, member number and applied loads. The information displayed in the text output 

window is controlled by a pull down menu. 

Help text gives on-line help for the user. The help text can be searched by index. 

3.2 TYPES OF STRUCTURES 

The preprocessor can be used to create four types of structure models. The most general 

case is the space frame structure, which is a three-dimensional frame with loads applied in 

any plane. A plane frame structure is bound by the global X-Y coordinate system with 

loads applied in the same plane. Space truss structure is a three-dimensional structure. It 

consists of members which are pinned at the ends. The members of the truss are subjected 

to axial forces only and there are no bending moments in the members. A plane truss is 

bound by the global X-Y coordinate system. 

13 
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3.3 COORDINATE SYSTEMS 

During the structural analysis, it is necessary to have a reference coordinate system for 

describing the structure, and the magnitude and direction of joint loads and member loads. 

Two types of coordinate systems are adopted in the preprocessor. The coordinate system 

used to reference information related to joints is known as the global coordinate system. 

The coordinate system used to reference individual members is known as the local 

coordinate system. 

3.3.1 GLOBAL COORDINATE SYSTEM 

All joint locations and aU joint loads are described in the global coordinate system. The 

global coordinate system consists of a set of right-hand orthogonal axes, X, Y and Z, 

which are oriented as show in Figure 3.2. 

y y 

x x o o 

z 

a) Space frame and space truss b) Plane frame and plane truss 

Fig. 3.2 Global coordinate system 
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The orientation of the global coordinate system is arbitrary as long as the relative 

orthogonality of the axes, as shown in Figure 3.2, is maintained. A common choice is to 

orient the X and Z axes in a horizontal plane with the Y axis extending upward. 

F or a plane structure, the X and Y axes will be in the plane of the structure. The location 

of the origin of the coordinate system is also arbitrary. 

3.3.2 LOCAL COORDINATE SYSTEM 

A local coordinate system is associated with each member. The local coordinate system 

also follows the right-hand rule. Figure 3.3 shows the local coordinate system of a beam 

member. The local coordinate system is defined as follows: 

y 

x 

z 

Fig. 3.3 Local coordinate system 
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The local x axis is always along the longitudinal axis of the member, positive from the 

smaller joint number to the larger joint number. The local y axis goes in the weak axis 

direction of the cross section. The local z axis is along the strong axis of the cross section. 

The positive direction of the local y and z axes is defined by the right-hand rule. 

3.4 FILE PROCESSING MENU 

The file processing function gives the user options for creating a new model, modifying an 

existing model, saving the current model on disk, loading a model from a file and exiting 

the program. 

,Save File 
Save File As •.. 

Fig.3.4 File menu 
Fig.3.4 File menu 

Selecting the New option from the file menu results in the creating of a new model. Also, 

all the existing data in memory is deleted. However, if an existing file has been changed 

and has not been saved or a new file has not been saved, a pop up message box will appear 

to remind the user to save the file. Selecting Yes will save the current data and then create 

16 
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a new model. Selecting No creates a new model without saving the current data. The 

Cancel option in the pop up message box transfers control to the previous screen. 

The Open file option on the file menu allows the user to load an existing structural model 

saved on disk. The user can type in the drive name, directory name and the file name or 

simply click the drive list box, directory list box and file list box to open the file. The data 

will be loaded into the preprocessor after this operation. Again, if a previous model has 

not been saved, a pop up message box will appear to remind the user to save the current 

file before opening another file. The Open File form is closed automatically after the file 

has been loaded. This form can also be closed without loading in the data by pressing the 

Escape key (Esc) or by clicking the Cancel button. The Open File form is shown in Figure 

3.5. 

File Name: =''''=I=!ttl;;;:..f _______ ---1 

Files: 
testl.dat 
test2.dat 
tesl3.dal 
test4.dat 

Fig 3.5 Open File form 

a:\data 

Directories: 
O,ives: 

I~a: II 

The Save File option is used for saving the structural model to a disk file. If a name has 

not been assigned to the file, the Save File As form will appear when the Save File option 

is selected. The Save File As form al10ws the user to select the file name, drive name and 
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directory name to which the file is to be saved. The Save File As form is closed 

automatically after the file has been saved. Pressing the Escape key (Esc) or clicking the 

Cancel button closes this form without saving the file. The Save File As form is shown in 

Figure 3.6. 

. .'. . ....... "Save file As' ....... :., .... :. 

file Name: L.;.;;1"~I=rm;;:...r _____ ---' 

Directories: c:\vb 

Drives: 

LJ zheng 

Fig. 3.6 Save File As form 

II 
li~i~:~:g§#~:d 

leiitietB 

The Save File As menu option is for saving the data file under a different nanle. Normally, 

this option is used to create a new file or to make a copy of an existing data file. 

The Exit menu option allows the user to exit the application. If an existing file has been 

changed and has not been saved, or a new file has not been saved, a pop up message box 

appears to remind the user to save the file before exiting the preprocessor. 
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3.5 DATA ENTRY FORMS 

The preprocessor utilizes a series of dialog boxes (or forms) for entering information 

regarding the structural modeL This section describes various types of forms and the 

information that has to be entered in these forms. 

3.5.1 FILE PATH FOR SUPPORTING FILES 

The preprocessor requires the following supporting files: 

1) AISC shape data base 

2) On-line help text 

These files should be installed on the hard drive or floppy diskette. It is necessary to 

specifY the location of these files so that the program can access them. The input form for 

entering the file path of supporting files is shown in Figure 3.7. 

Supporting file (file Path) 

Please enter the file path as follows: 

Drive name :\ Directory name \ ( Sub directory name) 

AISC Shape I a:\ 
data base: '--------------' 

Help text: I L-a_:\ ________ ---l 

Fig. 3.7 File path for supporting files 

The AISC Shape data base contains the section properties of the sections listed in the 

AISC Manual. (AISC, Load and Resistance Factor Design, First Edition, 1986) The 
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available shapes include C sections (channel), W sections, WT sections (Tee), S sections, 

L sections (angle), HP sections, M sections and MC sections. 

The on-line help file contains the help text. The preprocessor has a context sensitive help 

system which provides help on using the various input forms. It also provides detailed help 

on the required input parameters. 

3.5.2 STRUCTURAL DATA 

The type of structure to be analyzed is also specified in this form. The program can 

generate input files for four types of structures. The most genera1 case is the space frame 

structure, which is a three-dimensional frame with loads applied in any plane. A plane 

frame structure is bound by the global X-Y coordinate system with loads in the same 

plane. A truss structure consists of members which are pinned at the ends. The members 

of the truss are subjected to axial forces only and there are no bending moments in the 

members. A truss can be either a space truss or a plane truss. The default structure is the 

space frame structure. 

The structural data input form is shown in Figure 3.8. The information to be entered in 

this form consists of the project description, the type of structure, number of joints, 

number of members, number of load cases and number of load combinations. 
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'« " '.. . . . , ' .... , .. ,Structllral Oat;o ." :,.' .., '. . ,.,' :.., 

Ploiect 0 escription: 

Type of Structure: 

o Plane I.ursa 

o ,Space Truss 

@ .e.lana Frame 

o Space frame 

N umbel of J oinls: 

N umbel of Members: 

No. of load Cases: 

No. of load Combinations: 

Fig. 3.8 Structural data input form 

The automatic data checking mechanism for this form will perform the following checks: 

1) If this form is opened a second time and the total number of joints or the total number 

of members has been modified, the preprocessor will provide the user with the option to 

save the current data. If the user does not select this option, then all the data in memory 

will be erased except for the data in the structural data input form. This feature is useful 

when changing the geometry of structure such as adding or deleting a story of a building 

since it allows the user to save existing information regarding the structure. 

2) The maximum number of joints is limited to 100. The maximum number of members is 

also limited to 100. The maximum number of load cases and load combinations is 10. The 

preprocessor checks to make sure that these limits are not exceeded. The limits on the 

maximum number of members and maximum number of joints are based upon available 

computer memory, and the fact that the preprocessor is designed for the analysis small and 

medium size structures. However, it is possible to increase these limits by modifying the 

dimension statement in the program and recompiling the program. 
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3.5.3 SELECTION OF UNITS 

The preprocessor provides a choice of two types of units, the US system and the SI 

system. The default system of units used by the preprocessor is the US system. 

The units for the various quantities used in the US and SI systems are shown in Table 3.1. 

Table 3.1 Units for various quantities 

Quantity US SI 

Length ft m 

Force kip KN 

Moment kip-ft KN-M 

Temperature of °C 

Stress ksi GPa 

Angle degree degree 

3.5.4 MEMBER INCIDENCES 

Member incidences are used to define how members are connected to the joints. Each 

member has a starting joint and an ending joint. Thus, to define a member, it is necessary 

to specify the starting joint number and the ending joint number. Figure 3.9 shows the 

member incidences input form. 

The required input parameters for this form include the member number, starting joint 

number and ending joint number. The menlber number is generated automatically after the 

Update button is clicked. However, the user can also change the member number when 

necessary. 
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Auto 

Member Number: D 
Start Joint No.: D J~~IMlid I ~~~~Niil~~~~~~~~~1 

End Joint No: ~ I ~*~Iri!~~~~~j WMfetiMI 

Fig. 3.9 Member incidences input form 

This input form features an automatic member incidences generation function. The 

member incidences auto-generation form is activated by se1ecting the Auto menu option. 

The auto-generation form is shown in Figure 3. 10. The user needs to input the member 

incidence of the first member of a set of members, the mernber number increment, the 

member number of the first and last member in the group and the joint number increment. 

The preprocessor generates the member incidences for the remaining members in this 

group. 

Starting Member No.: D 
Ending Member No.: ~ 

M ember No. Increment: ~ 

Starting Joint No.: 0 
Ending Joint No.: ~ 

Joint No. Increment: [![] 

Fig. 3.10 Member incidences auto-generation form 
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The data checking mechanism performs the following checks: 

1) The member number cannot be greater than the total number of members. 

2) The member number cannot be less than or equal to zero. 

3) Two or more members cannot have the same member incidences. 

4) The joint number cannot be greater than the total number of joints. 

5) The joint number cannot be less than or equal to zero. 

6) The start joint number cannot be equal to the end joint number. 

7) Any duplicate input is detected and the user is given the option to keep previous data or 

to overwrite it. 

8) In the auto-generation mode, the preprocessor will also check to see whether the 

increment in joint number will result in a joint number that is larger than the total number 

of joints or the increment in the member number will result in a member number that is not 

included in the group to be generated. 

To ensure the accuracy of the structural model, the preprocessor requires that member 

incidences be entered for all members before closing this form. However, the user can 

close this form without entering member incidences for all members by clicking the Cancel 

button if necessary. 

3.5.5 MEMBER PROPERTIES 

Member properties include material properties and geometric properties. Separate input 

forms are provided for entering material properties and geometric properties. These forms 

are described below. 

3.5.5.1 MATERIAL PROPERTIES 

This input form allows the user to enter material properties for each member. The user can 

select from several predefined materials such as steel, concrete or can define others as 
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desired. Input parameters for material properties include the member number, the modulus 

of elasticity, the shear modulus (for space frame structures only), the coefficient of thermal 

expansion and concrete compressive strength. In US units, the preprocessor uses the 

following default values: 29,000 ksi for the modulus of elasticity and 11,200 ksi for the 

shear modulus for steel, 6.5xl0-6/0F and 6.0xI0-6/oF for the coefficient of thermal 

expansion for steel and concrete respectively. In SI units, the default values are 200,000 

Mpa for the modulus of elasticity and 77,000 Mpa for the shear modulus for steel, 

1.17x 1 O-s?C and 1.1 xl O-sfOC for the coefficient of thermal expansion for steel and concrete 

respectively. The modulus of elasticity and the shear modulus for concrete is computed 

from the concrete compressive strength. The type of material is not required by the output 

data file. The radio button for assigning the material type is for the purpose of obtaining 

default material properties only. 

There are two options for the assignment of material properties to members. The series 

input mode assigns material properties to a series of members. The single input mode 

assigns material properties to individual members. The default input mode is the series 

input mode. Figure 3.11 shows the member material properties input form. 

n·····~ ~ ...... ~ ...................... ~ ................ - ..................................... ~ ................................................................... ~ ............... "1 
!~ Material Properties 

.Qptions 

Start lDelDber nUlDber: [0 Modulus of elasticity E: I 29000 I ksi 

End lDelDber nUlDber: ~ Shear modulus G: I 0 I ksi 

Thelma. coefficient: I .0000065 
o S,teel (F y=36ksi) 

o Conclete 

COlDpresive strength f'c: [0 psi 

o 'y'ser Defined 

Fig. 3.11 Material properties input form 
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The data checking mechanism in this form checks for the following errors: 

1) Member number out of range 

2) Duplicate input 

3) Modulus of elasticity less than or equal to zero 

4) Shear modulus or coefficient of thermal expansion less than zero. 

The shear modulus is required only for space frame structures. The coefficient of thermal 

expansion is not required if there are no temperature loads. 

In the case of duplicate input, a message box appears on the screen. Selecting OK will 

overwrite existing data. Selecting Cancel will close the message box window and preserve 

the exi sting data. 

3.5.5.2 GEOMETRIC PROPERTIES 

The geometric properties input form allows the user to enter the geometric parameters for 

individual members or for a group of members. The input parameters for this form include 

the member number, cross sectional area and moment of inertia. The moment of inertia is 

not required for trusses since there is no bending in the truss model. For plane frame 

structures, the moment of inertia about the local z axis is required. It is necessary to input 

the moment of inertia about all three local axes for the members of a space frame structure 

since there is both bending and torsion in the members. 

If the US system of units is selected then geometric properties can be assigned from a data 

base containing AlSC shapes. The AlSC data base includes all of the shapes listed in the 

AlSC manual except for double angles. It contains the type of section, weight per foot, 

cross sectional area and moment of inertia about the local x, y and z axes. The following 

shapes are contained in the data base. 
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• C-Shape - Channels, 29 sections 

• L-Shape - Angles, 131 sections 

• HP-Shape - 15 sections 

• M-Shape - 8 sections 

• MC-Shape - 40 sections 

• S-Shape - 31 sections 

• W-Shape - 187 sections 

• WT-Shape - Tees, 187 sections 

The AISC shape data base is not available if the SI system of units is selected. In this case, 

the geometric properties have to be entered manually. Figure 3.12 shows the geometric 

properties input form . 

.Qptions 

Start member number: 1..--11_-....J 

End member number: 1..--11_0_--1 

@ AISC Shapes: 

o U Sjtf Defined: 

AISC-C 
AISC-HP 
AISC-L 
AISC-N 
AISC-NC 
AISC-S 
AISC-\II 
AISC-\IIT 

AISC Shape: 

Cl5X40 
Cl5X33.9 
Cl2><30 
Cl2><25 
Cl2><20.7 
C1OX30 
C1OX25 

Fig. 3.12 Geometric properties input form 

Area: 

Iz: 

114.7 

1404 

in(2) 

in(4) 
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The data checking mechanism for this form checks for the following errors: 

1) Member number out of range 

2) Duplicate input 

3) AISC shape not available in the data base 

4) Compressive strength of concrete less than or equal to zero 

5) Moment of inertia about the local z axis less than or equal to zero 

6) Moment of inertia about the local y axis less than zero 

7) Moment of inertia about the local x axis less than zero 

In the case of duplicate input, a message box appears on the screen. Selecting OK will 

overwrite existing data. Selecting Cancel will close the message box window and preserve 

the existing data. 

As was the case with the material properties input form, there are two options for the 

assignment of geometric properties. The geometric properties can be assigned to a series 

of members or to individual members. The default mode is to assign geometric properties 

to a series of members. 

The switch option rotates the axis of the member by 90 degrees. This option is provided 

for plane structures only. 

3.5.6 BETA ANGLE 

In the space frame model, it is important to know the relationship between the member 

local axis and the global axis for the structure. This relationship is defined by an angle 

called the beta (B) angle. The beta angle is defined as follows: 
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When the local x-axis is parallel to the global Y-axis, as in the case of a column, the beta 

angle is the angle through which the local z-axis has been rotated about the local x-axis 

from a position of being parallel and in the same positive direction of the global Z-axis. 

When the local x-axis is not parallel to the global Y-axis, the beta angle is the angle 

through which the local coordinate system has been rotated about the local x-axis from a 

position in which the local z-axis was parallel to the global X-Z plane and the local y-axis 

was in the same positive direction as the global Y-axis. Figure 3.13 shows the orientation 

of the local and global axes for beta angles of 0 and 90 degrees. The input form for the 

beta angle is shown in Figure 3.14. 

Y x v+ '?l' ~, beta=90 
beta=O z~ y x y 

2

x

X y x_tzy_x 
7 (JT beta = 0 

beta = 90 ~Y ~.C."x Z .A'" y X 

y~ ~z xl1 
x z z z -L bet. = 0 £ x beta = 90 

"2i y z 
x' 

Fig. 3.13 Orientation of the local and global axes for beta angles equal to 0 or 90 degrees 

The data checking mechanism for this form performs the following checks: 

1) Merrtber number out of range 

2) Duplicate input 

3) Beta angle less than zero or greater than 360 degrees 
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Nember Number: 0 
beta angle: 

I ~m~fttfil~1~~1~1~1 

I UfJ"B~~1 I m~~Hi!p~~~~1 I ~~~Uj"~~*~~~i 

Fig. 3.14 Beta angle input form 

In most cases, the beta angle will be 0 degrees. The default beta angle is 0 degrees so it is 

not necessary to input a zero beta angle. 

3.5.7 MEMBER RELEASES 

The preprocessor allows for the specification of internal releases in members at one or 

both ends of a member. One example is that of an internal hinge. An internal hinge can 

transfer shear force only. In this case, the moment at the end of the member must be 

released. 

In space frame structures, member releases can be the force in local x, y and z directions 

and the moment about the local x, y and z directions at each end of the member. In plane 

frame structures, member releases are limited to the force in local x and y directions and 

the moment about the local z direction. There are no moment releases for members of a 

truss. 

The member releases input form is shown in Figure 3.15. The necessary input data 

consists of the member number and the location and direction of the release. 
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Member Releases 

M ember Number: 11....-1 ___ ---' 

Start ioint: 

D Force x D Momenl x 

D Force, D Momenl y 

D Force z D Moment z 

End ioint: 

[8j [f.:9.~~:!::~] 

o Forcey 

o Force z 

D Momenl x 

D Momenly 

o Momenlz 

Fig. 3. 15 Member releases input form 

The following data checking is performed: 

1) Melnber number out of range 

2) Duplicate input 

3.5.8 JOINT CONSTRAINTS 

The joint constraints input form allows the user to specify constraints for given joints. A 

joint can be constrained against displacement in the global X, Y and Z directions or 

against rotation about the global X, Y and Z directions. The preprocessor provides several 

predefined joint constraints in order to simplify the amount of effort required in specifying 

joint constraints. 

The predefined joint types for a space truss model are as follows: 

• Pinned Constrained against displacement in the global X, Y and 

Z directions. 
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• Roller (Horizontal) Constrained against displacement in the global Y and Z 

directions. 

• Roller (Vertical) Constrained against the displacement in the global X and 

Z directions. 

• Roller (In the plane) Constrained against the displacement in the global X and 

Y directions. 

The joint constraints input form for a space truss is shown in Figure 3.16. 

Joint Number: [!J 

Joint Constraints: 

o f.inned @ 0 ther: 
o Roller (H orizontal) ~ Force K 
o Roller (yertical) r81 [f9.!f:~:·Yl 
o Roller (In the plane) 0 Force Z. 

1~;mmli;~~~1 

Inle&i~~j~1 

Fig. 3. 16 Joint constraints input form for a space truss 

For a plane frame model, the predefined joint types are as follows: 

• Fixed 

• Pinned 

• Roller (Horizontal) 

Constrained against displacement in the global X and Y 

directions and rotation about the global Z direction 

Constrained against displacement in the global X and Y 

directions. 

Constrained against displacement in the global Y 

direction. 
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• Roller (Vertical) Constrained against displacement In the global X 

direction. 

• Shear release (Horizontal) Constrained against displacement in the global Y direction 

and rotation about the global Z direction. 

• Shear release (Vertical) Constrained against displacement in the global X direction 

and rotation about the global Z direction. 

The joint constraints input form for a plane frame is shown in Figure 3.17 

Joint Number: [!J 

Joint Constraints: 

o Fixed @ Other: 
o f.inned 0 Force ~ 
o Roller (H ofizontal) 0 Force y o ~' ............................ ' 

Roller lY.eftical) t~.9..~~.~tkl 
o ~hear release [Horizontal) 
o Shear f~lease (Vertical] 

I ~IlMfiij~~~!J 

I ~~~~I;JIi~ti~1 

Fig. 3.17 Joint constraints input form for a plane frame 

For a space frame model, the predefined joint types are as follows: 

• Fixed Constrained against displacement in the global X, Y and 

Z directions and rotations about the global X, Y and Z 

directions. 

• Pinned Constrained against displacement in the global X, Y and 

Z directions. 
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The joint constraints input form for a space frame is shown in Figure 3.18 . 

. . ' Joint Co nSlt8in1s.. {Sp ace Framer ..... >: 

Joint Number: [!] 

Joint Conslr aints: 

o Fixed 
o f.inned 
@ Other: 

[8]- Force K D Moment X 
[8] Force y D Mom~nt Y 
[8] [f9.~~i:zJ D Moment Z 

Fig. 3.18 Joint constraints input form for a space frame 

For a plane truss model, the predefined joint types are as follows: 

• Pinned Constrained against displacement in the global X and Y 

directions. 

• Roller (Horizontal) Constrained against displacement In the global Y 

direction. 

• Roller (Vertical) Constrained against displacement 1n the global X 

direction. 

The joint constraints input form for a plane truss is shown in Figure 3.19. 
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Joint Number: IL-l ___ ~ 

Joint Consh aints: 

@ f.inned 

o Roller (Horizontal) 

o Roller iY.ertical) 

Fig. 3. 19 Joint constraints input form for a plane truss 

In addition to the predefined joint types, there is an option for entering a user-defined joint 

constraint. 

The data checking mechanism checks for the following types of errors: 

1) Joint number out of range 

2) Duplicate input 

In the case of duplicate input, a message box appears on the screen. Selecting OK will 

overwrite existing data. Selecting Cancel will close the message box window and preserve 

the existing data. 

3.5.9 JOINT COORDINATES 

The geometry of structural model is specified by joint coordinates. The joint coordinates 

input form allows the user to enter the coordinates of each joint in the structure. The input 

parameters for this form are the joint number and the coordinates of the joint in the global 

coordinate system. For space frames or space trusses, the global X, Y and Z coordinates 
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are required for each joint. In the case of a plane truss or a plane frame, the global Z 

coordinate is not required. Figure 3.20 shows the joint coordinates input form. 

~ , , .: . '.: .' , Jolnl Co(trdin~te$ .', . ,'. '. :.... . . '. 
Auto 

Joint Number: \& I 
Joint Coordinatea: 

Coordinate X: ~ m 

Coordinate Y: CO m 

Coordinate Z: \ 0 I m 

I~~.ili~' 
I ;~;~]lIiyl~~i~;i~j 

Fig. 3.20 Joint coordinates input form 

I ;iwtitit.~l:1 

I mali.it~~t~~1 

The data checking mechanism checks for the following errors: 

1 ) Joint number out of range 

2) Duplicate input 

3) Two or more joints have the same joint coordinates 

In the case of duplicate input, a message box appears on the screen. Selecting OK will 

overwrite existing data. Selecting Cancel will close the message box window and preserve 

the existing data. 

The joint coordinates input form has an automatic joint coordinates generation feature. In 

the auto-generation mode, joint coordinates can be generated by giving the joint number 

of the first and last joint in the series, the joint number increment, the joint coordinates of 
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the first joint and the increment in these coordinates. The joint coordinates auto

generation input form is shown in Figure 3.21. 

S tailing Joint No.: 

Ending Joint No.: 

Joint Number Inclement: 

Starting Joint Coordinates: Coordinates Inclement: 

X axis: 10 
Yaxis: 10 
Z axis: 10 

Fig. 3. 21 Joint coordinates auto-generation form 

The data checking mechanism in this form also checks whether the joint number increment 

results in a joint number that is not included in the group to be generated. 

To ensure the accuracy of the structural model, the preprocessor requires the user to enter 

joint coordinates for all joints before closing this form. It is however, possible to exit 

without entering the data for all joints by simply clicking the Cancel button. 

The preprocessor automatically computes the length for all members after the joint 

coordinates of all joints and member incidences of all members have been entered. 

Member lengths are not calculated if the joint coordinates input form is dismissed prior to 

entering all joint coordinates. 
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3.5.10 LOADS 

The loads applied on a structure include joint loads, member loads and prescribed 

displacements. The preprocessor has separate input forms for entering the different types 

of loads. In addition, there are optional input forms that allow the user to enter load case 

descriptions and load combinations. These input forms are described below. 

3.5.11 LOAD CASE DESCRIPTIONS 

All loads are associated with a load case. The load case description input form allows the 

user to enter a brief description for each load case, such as Dead Load, Live Load, etc. 

The required input parameters for the load case descriptions input form are the load case 

number and its description. The load case description can be entered directly by selecting 

from several predefined load case descriptions in the list box or by typing in the text for 

the load case description in the text box provided for this purpose. The load case 

descriptions input form is shown in Figure 3.22. 

Load Case N umber: I o...;;;;6~~ _---' 

Load Case Description: 

DEAD lOAD 
LIVE lOAD 
LIVE ROOF LOA[) 
WIND LOAD 
SNOW lOAD 

Fig. 3.22 Load case descriptions input form 

Ij~~.li~ll 

I i~~i1:I~lj.lll1lm~~1 
I j~l~l~i~B.i~~t~~' 

I ~ml§llj~~j~llill 
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The data checking mechanism for this form performs the following checks: 

1) Load case number cannot be greater than the total number of load cases or less than O. 

2) Duplicate input 

3) Same load case description cannot be entered a second time. 

3.5.12 LOAD COMBINATIONS 

With the adoption of Load and Resistance Factor Design (LRFD), the response of the 

structure under different load combinations has to be considered in the design process. 

The preprocessor allows the user to specify up to ten load combinations with each 

combination containing up to five load cases. 

The required input parameters for the load combinations input form are the load case 

descriptions and the corresponding load factors. This form shall not be opened unless all 

load case descriptions have been entered. It is not necessary to type in the load case 

descriptions in this form since all load case descriptions are listed in a list box allowing for 

easy selection of the load case. The load combinations input form is shown in Figure 3.23. 

Load Combination Number: 

Load Cases: 

SELF\IIEIGHT SELFWEIGHT 
WIND FROM LEFT 

WIND FROM LEFT 

Fig. 3.23 Load combinations input form 

Load Factors: 

11.2 

1·11 
10 
10 
10 

39 



Preprocessor 

The data checking mechanism performs the following checks: 

1) Load combination number cannot be greater than the total number of load combinations 

or less than zero. 

2) The same load case cannot be used more than once in a load combination. 

3) Duplicate input 

3.5.13 JOINT LOADS 

Joint loads can be specified either as forces acting at the joint or as moments. In a space 

truss structure, a joint load can be a force acting in the global X, Y or Z directions. In a 

plane truss, joint loads have to be in the global X-Y plane. For a plane frame structure, a 

joint load can be a force acting in the global X and Y directions or a moment about the 

global Z direction. For a space frame, joint loads can be forces or moments acting in the 

global X, Y and Z directions. The input form for joint loads is shown in Figure 3.24. 

load case number: 10 
J oint load number: 11 1 ht agnitude: 

::::====: 
Joint number: 1 .. I 1-15 1 kips or kips-ft 

@ force 

Direction: 
o Global X 
@GlobalY 
o Gk~hd? 

o Moment 

Im~~~~N~~~liia~M-:~m*d 

1~~~HH;riii~~~Jiii~'iitrm~~~~~1 

I m~HiI~~~~~11 I ~~~~~~~:~fiii~~~~m~~~ 

Fig. 3.24 Joint loads input form 
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The input parameters for this form include the load case number, joint load number, joint 

number, and direction and magnitude of the load. Depending on the type of structural 

model, the preprocessor disables the input fields that are not applicable to that modeL 

The NextlPrev. Load Case buttons are provided for the selection of the load cases. The 

joint load number is the number of joint loads for a given load case. The joint load number 

is generated automatically. The joint number specifies the joint at which the load IS 

applied. The direction of the joint load is defined by the global coordinate system. 

The data checking mechanism for this form performs the following checks: 

1) Load case number out of range 

2) Joint load number out of range 

3 ) Joint number out of range 

4) Joint load type (force or moment) not selected 

5) Joint load direction not selected 

6) Joint load magnitude equals zero 

7) Duplicate input 

3.5.14 ME:MBER LOADS 

Member loads are specified by the type of member load, the plane in which it acts, the 

distance from the start of the member to the load, the magnitude of the load and the 

member number of the member on which the load acts. 

The direction of the member load is defined in the local coordinate system. For a truss, the 

direction of member load is always along the length of the member since the load is axiaL 

In a plane frame structure, transverse member loads act in the local x-y plane. If the 
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structure is a space frame, a transverse member load is decomposed into forces acting in 

the local x-y plane and local x-z plane. 

Member loads are classified as: 

1) Concentrated load 

2) Uniform load 

3) Linear load 

4) Uniform temperature change. 

3.5.14.1 CONCENTRATED LOADS 

A concentrated load is also called a point load. It is a force acting on the member at a 

point. Concentrated loads can be either axial or transverse. The input form for 

concentrated loads is shown in Figure 3.25. The required input parameters include the 

load case number, member number of the mernber subjected to the concentrated load, the 

magnitude of the load, distance from the starting joint to the point at which the load acts 

and the direction of the load. 

3.5.14.2 UNIFORM LOADS 

A uniform load acts along the member. It can be axial or transverse. The input form for 

uniform loads is shown in Figure 3.26. The required input parameters for the uniform load 

include the load case number, the member number of the member on which the load is 

acting, and the magnitude and the direction of the load. 

3.5.14.3 LINEAR LOADS 

A linear load acts on a portion of member and increases or decreases linearly in magnitude 

from the left to the right side. A linear load is the general case for the uniform load. 
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Load Case Number: 11 
Member Number: 11 I 
Magnitude p: 

110 I k.ip 

Distance d: 15 r 
ft 

Load Direction: 

Fig. 3.25 Concentrated loads input form 

Load Case Number: 

Member Number: 

Magnitude w: 

Load Direction: 

@ I~~:~f!~:l 
o Local 2: 

o :;A'?'(;" {~~ :~::: 

11 
11 I 
110 I k.ip/ft 

I ~1!~~jl,=lIi*1~1 

I ![~l~~1[a'M~~~~~1[1~~1 I ~~~~1[ji_l~ji~jl 

Fig. 3.26 Uniform loads input form 
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A uniform load can be expressed in the form of a linear load which has the same 

magnitude along the length of the member. The input form for linear loads is shown in 

Figure 3.27. 

Load Case Number: 

Member Number: 

Magnitude wl: 

Distance dl: 

Magnitude w2: 

Disdance d2: 

Load Direction: 

o Local x: 
@ Local,!.: 

o t H{::d i~:.: 

\9 
\-.9 kip 

\ 0 ft 

1 .. 9 kip 

\ 5.830 \ ft 

I~~jj_~l~~jl Ij~jlilli~~~~j 

Im*!~I,gl~~l~ll 1~~~~~illlli~~~lJ 

11~j~1~1~.t~1lil 

Fig. 3.27 Linear loads input form 

The required input parameters for a linear load include the load case number, the member 

number of the member on which the load is acting, the magnitude of the load at both sides, 

the distances from the start joint to the start and end of the load, and the direction of the 

load. 

3.5.14.4 UN1FORM TEMPERATURE CHANGE 

A temperature load is different from the previously described member loads. To simplify 

the analysis, it is assumed that the temperature change is uniform. Therefore the required 

input parameters for temperature loads input form are the load case number, the member 
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number of the member subjected to the temperature change and the amount of 

temperature change. The input form for a uniform temperature change is shown in Figure 

3.28. 

load Case Number: 11 
Nember Number: 

N agnitude t: 
11 I 
110~ I 

II~jijl_jj~j~~1 

I ~1~1ilfl~1~1~~11 

deg (FJ 

Fig. 3.28 Uniform temperature change input form 

3.5.14.5 DATA CHECKING 

All of the member load input forms have features for checking input errors. The type of 

checks made include: 

1) Load case number out of range 

2) Member number out of range 

3) Member load direction not selected 

4) Member load magnitude equals to zero 

Note that in the linear loads input form, the load at one side can be zero. 

5) Member load location out of range. Note that for the concentrated load, 0 < d < L 

where L is the length of the member, d is the distance from the start joint to the point at 

which the load acts. For the linear load, 0 ~ dl < d2 ~ L where dl and d2 are distances 

from the start joint to the start and end of the load. 
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6) Duplicate input. 

3.5.15 PRESCRIBED DISPLACEMENTS 

A prescribed displacement is specified by the direction of the displacement, the type of 

displacement, the magnitude of the displacement and the joint number of the joint 

subjected to the prescribed displacement. In a truss, the prescribed displacement can only 

be a translation. In a frame structure, the prescribed displacement can be either a 

translation or a rotation. The input form for the prescribed displacement is shown in 

Figure 3.29. 

load case number: 

Pre. displacement No.: 11 I Displacement: 
:::====: 

Joint number: 14 11.1 I ft or degree 

@ Translation 
o R~ation 

Direction: ---...., 
o Global X 
@ GlobalY 
o l~l(}baIZ 

I IDiilmid I ~])ilMi~~~~~1 
I ~;~~~;!lm~~t~1 I ~;;~~fNiit;~~i~~;' 
I ~~;~~~jj~MiinNidi!Mii!~j!~mj 
I ~;!!1~j@Piii~mm!lt.iii!j~!!;;;~j!;!!i!1 

Fig. 3.29 Prescribed displacements input form 

The following checks are performed: 

1) Load case number out of range 

2) Prescribed displacement number out of range 

3) Joint number out of range 

4) Prescribed displacement type (translation or rotation) not selected 
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5) Prescribed displacement direction not selected 

6) The displacement equals to zero 

7) Duplicate input 

3.6 DATA REVIEW 

The preprocessor has two facilities for reviewing the input data. The data review window 

displays the data entered in the form of tables. The graphical output function displays the 

data in graphical form. These are described below. 

3.6.1 NUMERICAL DATA REVIEW 

This form offers a very convenient way of checking the input data. Unlike the individual 

input forms which display only one set of data, the data review form can display up to 15 

lines of information at a time. The data review window has several menus and sub menus 

similar to the menus in the main form. All of the input data can be reviewed by making a 

selection from this menu. The numerical data review form is shown in Figure 3.30. 

The following input data can be reviewed through the data review window: 

1) Structural data 

2) Member incidences and member lengths 

3) Geometric and material properties 

4) Beta angles 

5) Joint releases and member releases 

6) Joint coordinates 

7) Load case descriptions and load combinations 

8) Joint loads, member loads and prescribed displacements 
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The data review form can also be activated by clicking the List button in the other input 

forms. The current input form will be resumed automatically after the data review form is 

closed. 

11. ... ..... ..: ........ Input Oa1_ ti~J·.· .... '. '" . ... . .. . 
Structure Member Joint Loads 

Member Start ioint End ioint Length 
Number Number Number 
1 1 3 20 
2 3 7 15 
3 2 6 20 
4 6 8 15 
5 3 4 10 
6 4 5 10 
7 5 6 10 
8 7 12 5.830952 
9 12 14 5.830952 
10 14 16 5.830952 
11 15 16 5.830952 
12 13 15 5.830952 
13 8 13 5.830952 
1. 9 12 3.905125 
15 9 14 6.5 

Please click MORE bullon for more data. 

Fig. 3.30 Numerical data review form 

3.6.2 THREE-DIMENSIONAL GRAPHICS 

The preprocessor takes advantage of the Visual Basic graphics functions to display the 

geometry of the structure. Figure 3.31 shows the graphics output form. The three

dimensional graphics display function has the following features: 
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3.6.2.1 STRUCTURE 

The structure is scaled automatically according to the joint coordinates. This function 

makes is possible to display the structure so that it fits in the display window. However, 

some distortion of the displayed image may occur due to scaling. 

Since it is necessary to display the structure prior to display other information such as joint 

numbers, member numbers and loads, all other display functions are disabled until the 

structure is displayed. 

Fig. 3.31 Graphics output form 

3.6.2.2 JOINT LOADS 

Joint loads include forces and moments. A single arrow is used to display a force acting at 

a joint and a double arrow is used to display a joint moment. The direction of the joint 

moment is based on the right-hand rule. The menu items Forces and Moments serve as 
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toggle switches for turning onloffthe display of the joint forces and joint moments. These 

menu items are grayed if there are no joint loads for the given load case. 

3.6.2.3 MEMBER LOADS 

The different types of member loads are shown separately. The menu item corresponding 

to a particular type of member load is grayed if there is no member load of that type in the 

given load case. The display of loads can be erased from the screen by clicking the 

corresponding menu item a second time. 

3.6.2.4 PRESCRIBED DISPLACEMENTS 

Prescribed displacements include translations and rotations. A single arrow is used to 

show a translation and a double arrow is used to show a rotation. Again, the direction of 

the rotation is based on the right-hand rule. The menu items Translation and Rotations 

serve as toggle switches for turning on/off the display of the translation and rotations. 

These menu items are grayed if there are no prescribed displacements for the given load 

case. 

3.6.2.5 JOINT NUMBERS AND MEMBER NUMBERS 

Joint numbers and member numbers can be displayed on the structure by clicking the 

corresponding command buttons and can be erased by clicking the same button a second 

time. 

3.6.2.6 NEXTIPREV. LOAD CASE BUTTONS 

The NextlPrev. Load Case buttons anow for the selection of the next or previous load 

case. The load case description is also displayed on the screen. 
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3.7 THE HELP SYSTEM 

The preprocessor has an on-line help system that is context sensitive. Each form has a help 

button which activates a help form that provides an explanation of the steps required to 

enter the data in the form. There is also a help index which provides access to help on a 

specific topic. The index help form is shown in Figure 3.32. 

In the space frame model.. it is important to know the relationship between lhe 
member local axis and the global axis for the structure. T his relationship is 
defined by an angle called beta angle_ T he beta angle is defined as follows: 

When the local x-axis is parallel to the global Y-axis, as in the case of a 
column in a structure .. the beta angle is the angle through which the local 
z-axis has been rotated about the local x-axis from a position of being parallel 
and in the same positive direction as the global Z-axis. 

When the local x-axis is not parallel to the global Y-axis, the beta angle is 
the angle through which the local coordinate system has been rotated about the 
local x-axis from a position in which the local z-axis was parallel to lhe global 

Fig. 3.32 Index help form 

3.8 ABOUT 

About form shows information about the preprocessor, the current version and the author. 

The about form is shown in Figure 3.33. 
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Version 1.0 

A Preprocessor for the Analysis 
of Space Frame Structures in the 
Microsoft Windows Environment 

by 

Zhiiun Zheng 

Kamal B. Aoiiani, Chairman 

January .. 1993 

Fig. 3.33 About form 
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4.1 SUMMARY 

CHAPTER FOUR 

SUMMARY AND CONCLUSIONS 

A preprocessor for the analysis of space frame structures was developed. The 

preprocessor is designed to run in the Microsoft Windows environment which is widely 

available on personal computers. The program is written in the Microsoft Visual Basic 

programming language. 

The preprocessor allows the user to enter information regarding the geometry of the 

structure and applied loading. The basic functions of the preprocessor include the ability to 

read and write files containing structural data, and to review and modify information 

regarding the structure. The preprocessor can create and read data files for the plane truss, 

plane frame, space truss and space frame structures. 

The program is fully event-driven and the user has the complete control over the order of 

tasks to be performed. The preprocessor provides a user-friendly interface and takes 

advantage of standard Windows graphical user interface elements such as pull down 

menus, dialog boxes, scroll bars, list boxes, command buttons and radio buttons. A 

sophisticated data checking mechanism reduces data-entry errors to a minimum. The 

preprocessor also features three-dimensional graphics which can display the structural 

geometry and applied loads. 

The preprocessor features a file menu that is standard in Windows applications. It 

provides the option for creating a new structural model, modifying an existing structural 

model, and saving a structural model on disk as a text file in a format that is suitable for 

use by an analysis program. 
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A series of input forms are provided for entering information regarding the structural 

model. These input forms are accessed by selecting the corresponding menu item in the 

main form. The preprocessor also provides for two systems of units, English and SI. An 

AISC shape data base which contains all sections listed in the AISC Manual is used to 

assign geometric properties to the members. Automatic generation of member incidences 

and joint coordinates is also available. 

To ensure the accuracy of the structural model, each data entry form features a 

sophisticated data checking mechanism which performs a series of checks on the input 

data. It provides warning messages for most of the common errors that can occur when 

entering the structural model such as missing member incidences, missing joint numbers 

and joint coordinates, duplicate input and invalid joint numbers or member numbers. 

In addition to the data checking mechanism, the preprocessor also features a tabular data 

review window and a three-dimensional graphics display window. The tabular data review 

window can be used to display all the input data simply by selecting the corresponding 

menu item. The three dimensional graphics displays the structural geometry and applied 

loads. 

The preprocessor also has a context-sensitive on-line help system. The help system 

provides information on input parameters, input procedures for each input form, and 

explains the function of the various controls used in the preprocessor. 

4.2 CONCLUSIONS 

The preprocessor performs well in creating small and medium size structural models. It is 

a valuable tool for introducing the basic concepts of computer analysis of structures to 
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beginners. Data files generated by the preprocessor for several types of structural models 

have been tested by the processor program and have been proved to be acceptable. 

However, the preprocessor does require that the user enter detailed information regarding 

the structural model through various input forms. This makes it impractical for creating 

large structural models. 

The program is a good illustration of the use of the Visual Basic programming language 

for developing Windows applications. The Visual Basic programming environment 

provides a good solution to the otherwise difficult and tedious task of developing 

Windows applications using a procedural language such as C. Suggestions for future 

enhancements to the preprocessor are discussed in the next section. 

4.3 FUTURE MODIFICATIONS 

A possible future modification to the preprocessor would be the enhancement of the 

current three-dimensional graphics output. Since the primary objective of the project was 

to create a user-friendly preprocessor in the Microsoft Windows environment, the current 

graphics output only shows essential information such as joint numbers, member numbers 

and applied loads. It would be useful to develop new graphics output subroutines that 

provide better display quality and allow for rotation of the structure. 

Another possible modification would be to combine the preprocessing, structural analysis 

and post-processing features into one integrated program. The main form has the menus 

that contain all the functions for structural analysis so that the analysis can be performed in 

an integrated program, without having to exit the preprocessor, run the processor and 

then run the post-processor. The information regarding the analysis of structure such as 
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input data file, structural geometry and the results of the analysis in graphics can then be 

printed by selecting the corresponding menu items. 

The preprocessor is very useful for entering data for small and medium size structural 

models and is a significant improvement over the traditional character based approach to 

entering data. However, for large structures it would be time consuming to use any 

preprocessor that relies primarily on keyboard input for entering the data for the structural 

model. For large structures, it would be more efficient to have a graphics based 

preprocessor with features similar to those currently available in CAD packages. This 

would provide the capability of defining members, joints and loads by using a pointing 

device such as a mouse. The capabilities of the CAD engine could then be used to perform 

many functions, such as generating the mesh, copying members and joints, assigning 

member properties to individual members or groups of members, deleting members and 

applying loads. Since all of the work would be conducted in a graphical environment, 

there would be constant visual feedback which would significantly reduce the possibility of 

input errors. 
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APPENDIX A 

USER'S GUIDE 

This section provides information regarding the use of the preprocessor. It presents a brief 

overview of the basic operations that are common to most Windows programs and then 

presents a description of the various input forms that are provided in the preprocessor. 

A.I HARDWARE AND SOFTWARE REQUIRE:MENTS 

A.I.I HARDWARE 

The preprocessor will run on an mM compatible personal computer with a 80286 or 

higher processor and a minimum of I MB RAM. However, a 80386 processor, 4 MB 

RAM and a mouse are strongly recommended. 

A.I.2 SOFTWARE 

The preprocessor runs under Microsoft Windows Version 3.0 or higher. The Microsoft 

Visual Basic dynamic link library VBRUNIOO.DLL is also required. 

A.I.3 INSTALLING THE PREPROCESSOR 

Copy the executable file named Prep.exe from the floppy disk to the hard disk. Use the 

New menu item in the File menu of the Windows Program Manager application to create a 

new Program Item. You will need to specify the path of the executable file and the 

description of the preprocessor. You can also use the Browse option to locate the file. 

Once the icon for the preprocessor appears in your selected program group, you can run 

the preprocessor by double clicking on the icon. 

Copy the directories AISC, HELP which contain the AISC shape data base and help text 

to the hard drive preferably in the same sub directory as the executable file. The 
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supporting files can also be installed in another sub directory. The preprocessor will allow 

you to specify the path for these supporting files. 

A.2 BASIC SKILLS 

The preprocessor uses the same controls as the standard Windows controls. These 

controls include drop down menus, command buttons, radio buttons, check boxes, scroll 

bars, list boxes, combo boxes, file list box, directory list box and drive list box. Text boxes 

are used to accept the data. 

A.2.1 USING STANDARD CONTROLS 

A.2.I.1 MENU 

A menu in the preprocessor, which drops down from the menu bar, initiates tasks such as 

opening a file or entering data, depending on the menu item selected. 

To select a menu item, simply click the menu name, or press the Alt key in combination 

with the underlined letter of the menu name. To cancel a menu item, click outside the 

menu or press the Escape (Esc) key. 

To choose an item from a drop down menu, you need to first select the menu, then click 

on the menu item or type in the underlined letter of the menu item name. Figure A.I 

shows the main form of the preprocessor with menus and submenus. 
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Fig. A.I Menus and submenus 

A.2.1.2 RADIO BUTTONS 

Radio buttons display options that can be toggled on or off. Usually, radio buttons are 

used as part of a group to display multiple choices from which a selection can be made. 

To select a radio button, move the mouse cursor over the radio button and click the left 

mouse button, or press the Alt key in combination with the underlined letter of the radio 

button name. A selected radio button is indicated by a solid circle in the center. Only one 

radio button can be selected from a group of radio buttons. When one button is selected, 

the other radio buttons in the group are automatically cancelled. Figure A.2 shows a group 

of radio buttons. 
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o Option2 

Radio Buttons 

Figure A.2 Radio buttons 

A.2.t.3 COMMAND BUTTONS 

A command button performs a specific task as indicated by the name specified on the 

button. A command button is selected by moving the mouse cursor over the button and 

then clicking the left mouse button. A command button can also be selected by pressing 

the Alt key in combination with the underlined the letter of the command button name. 

Figure A.3 shows a command button. 

Command Bullon 

Fig A.3 Command button 

A.2.l.4 CHECK BOXES 

A check box displays an option that can be turned on or off It has two states which are 

on and off (or yes and no). To select a check box, simply move the mouse cursor over the 

check box and click the left mouse button. A check box can also be selected by pressing 
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the Alt key in combination with the underlined letter of the check box name. A selected 

check box is indicated by an "X". More than one check boxes can be selected in a group. 

The same procedure is used to clear a check box. Figure A.4 shows two check boxes 

(checked and unchecked). 

~ f.~h~.~·~.fj 

D Check2 

Check Boxes 

Fig A.4 Check boxes (Checked and unchecked) 

A.2.1.S SCROLL BARS 

Scroll bars are graphical tools for quickly navigating through a long list of items, and for 

indicating the current position on a scale. A horizontal scroll bar allows movement in the 

horizontal direction while a vertical scroll bar allows scrolling up or down a list. To use 

the scroll bar, simply click the arrow which indicates the direction you want, or click the 

indicator on the scale and move it right/left or up/down. Figure A.S shows both horizontal 

and vertical scroll bars. 
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Scroll Bars 

Fig A.5 Scroll bars (Horizontal and vertical) 

A.2.1.6 LIST BOXES 

A list box displays a list of items from which a selection can be made. A scroll bar is 

added to the list box if the number of items exceeds the number of items that can be 

displayed. To select an item in the list box, move the mouse cursor over the item and 

press the left mouse button. An item in the list box can also be selected by using the arrow 

keys to move up or down and then pressing the Enter key. Figure A.6 shows a list box. 

List Box 

Fig A.6 List box 

A.2.1.7 COMBO BOXES 

A combo box combines the features of a text box and a list box. Use the cornbo box to 

make a selection by typing text into a text box or by moving the mouse cursor over the 

item and pressing the left mouse button. Figure A.7 shows a combo box. 
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Item 11 r .. ': 
Item 1 
Item 2 

Combo Box 

Fig. A.7 Combo box 

A.2.1.8 FILE LIST BOX 

A file list box is used for locating and selecting files to be opened or saved. A scroll bar is 

added to the file list box if the number of files exceeds the number of files that can be 

displayed. A file is selected by moving the mouse cursor over the file name in the file list 

box and then clicking the left mouse button. Figure A.8 shows a file list box. 

File list Box 

Fig A.8 File list box 

A.2.1.9 DIRECTORY LIST BOX 

A directory list box displays a list of sub directories. A scroll bar is added if necessary. A 

directory can be select by moving the mouse cursor over the directory name in the 

directory list box and then clicking the left mouse button. Figure A.9 shows a directory list 

box. 
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Director, list Box 

Fig A.9 Directory list box 

A. 2.1.10 DRIVE LIST BOX 

A drive list box displays a list of valid disk drives. A drive is selected by moving the mouse 

cursor over the drive name in the drive list box and then clicking the left mouse button. 

Figure A.I 0 shows a drive list box. 

Drive list Box 

Fig A.I 0 Drive list box 

A.2.2 ENTERING DATA IN TEXT BOXES 

All edit fields in the preprocessor are followed by input prompts. Except for the option 

buttons and check boxes which are used to accept multiple choices, text boxes are used to 

enter all numeric and textual data. 
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Data can be entered in a text box when it has the input focus. A text box has the input 

focus if the text is highlighted. Pressing the Tab key moves the focus to the next control 

item in the form. Pressing the Enter key moves the focus among a group of text boxes 

only_ However, moving the mouse cursor to the text box and clicking the left mouse 

button will also move the input focus to the text box. After the data has been entered, 

press the Enter key to move to the next item. 

All text boxes in the preprocessor which require data entry have a single border. Text 

boxes without borders are used for displaying information. 

A.2.3 COrv1MAND BUTTONS 

All input forms are equipped with several standard command buttons. These command 

buttons perform a similar function in all of the input forms. 

A.2.3.1 THE OK BUTTON 

The OK button closes the input form after all data for this input form has been entered. In 

input forms such as the j oint coordinates input form and the member incidences input form 

where data is critical for the accuracy of the model, the OK button also performs an 

automatic check to ensure that all data has been entered. In addition, if the input mode is 

IrNew" , the OK button enables the menu for the next input form. 

A.2.3.2 THE CANCEL BUTTON 

The Cancel button allows the user to close the input form at any time. Pressing the Esc 

key will also close the input form. 
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A.2.3.3 THE HELP BUTTON 

When the Help button is selected, a window containing instructions on basic input 

procedures for the input form is displayed. 

A.2.3.4 THE LIST BUTTON 

The List button opens a form which allows the user to review the input data without 

having to quit the current input form. When the data review form is closed, the current 

input form is activated again. 

A.2.3.5 THE UPDATE BUTTON 

The Update button is designed for accepting the data after the user has entered a set of 

data items. It also initiates automatic checking for input errors. If an error is detected, a 

message box appears on the screen to indicate the type of error and the user is provided 

with an opportunity to correct the error. 

A.2.3.6 THE DELETE BUTTON 

Delete button is provided for editing data. It will erase data currently displayed on the 

screen. 

A.2.3.7 THE NEXT AND PREVo BUTTON 

The Next and Prevo buttons are provided wherever necessary. These buttons allow the 

user to view previous or next data. 

A.2.3.S THE NEXT AND PREVo LOAD CASE BUTTON 

The Next and Prevo Load Case buttons are used in the load input forms and in the graphics 

output form. These buttons allow you to select the particular load case of interest. 
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A.3 BASIC OPERATION 

A.3.1 FILE PATH FOR SUPPORTING FILES 

When you start the preprocessor for the first time, the first form that appears on the screen 

is the form for entering the file path for supporting files. Enter the file path for the AISC 

data base file in the first text box, for example as "C:\", then press the Enter key. Enter the 

file path for the help file in the second text box. Click on the OK button or press the Alt 

key in combination with the 0 key to close this form. The preprocessor will then create a 

file called "FILE.INI" in the C drive. The next time you start the preprocessor, the 

program will automatically read this file. The file path input form will not appear if 

"FILE.INI" exists in C drive. 

A.3.2 MAIN FORM 

The main form has the caption "Preprocessor". It has a menu bar which contains of all the 

menus for the various operations that can be performed. 

A.3.3 CREATING A NEW MODEL OR MODIFYING AN EXISTING MODEL 

A.3.3.1 CREATING ANEW MODEL 

1. Select the File menu. 

Move the mouse cursor over the menu and click the left mouse button; or press the Alt 

key in combination with the F key. 

2. Select the New menu item in the File menu. 

Drag the mouse cursor over the menu item and click the left mouse button or press the N 

key. A pop up window will appear to remind you to save the current data if the current file 

is a new file and has not been saved or if the current file has been changed and has not 

been saved. 
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A.3.3.2 TO MODIFY AN EXISTING MODEL 

1. Select the File menu. 

Move the mouse cursor over the menu and click the left mouse button; or press the AIt 

key in combination with the F key. 

2. Select the Open menu item in the File menu. 

Drag the mouse cursor over the menu item and click the left mouse button or press the 0 

key. A pop up window will appear to remind you to save the current data if the current file 

is a new file and has not been saved or if the current file has been changed and has not 

been saved. 

3. Click the drive list box in the Open File form to select the drive name. 

4. Click the directory list box in the Open File form to select the directory name. 

5. Click the file list box in the Open File form to select the file name. 

You can also select the file name and directory path by entering it in the File Name text 

box, such as, for example "a:\test.dat". 

6. Click on the OK button or press the Enter key to open the file. 

You can also double click on the file name in the file list box to open the file. 

A.3.4 STRUCTURE TYPE AND SIZE 

1. Move the mouse cursor over the Structure menu item and press the left mouse button; 

or press the AIt key in combination with the S key to open the Structural Data input form. 

2. Enter the Project Description in the first text box and press the Enter key. The 

description is limited to one line of text. 

3. Enter the total number of joints in the second text box and press the Enter key. 

4. Enter the total number of members in the third text box and press the Enter key. 

5. Enter the total number of load cases in the fourth text box and press the Enter key. 

6. Enter the total number of load combinations in the fifth text box and press the Enter 

key. 
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7. Click on one of the radio buttons to select the type of structure from the following 

options: space truss, plane frame, space frame or plane truss. 

8. Click on the OK button to close this form. 

A.3.S MEMBER INCIDENCES INPUT 

A.3.S.1 MEMBER INCIDENCES FOR INDIVIDUAL MEMBERS 

1. Select the Merr.ber menu from the main form to display the items in this pull down 

menu. 

2. Select the Incidences menu item to open the Member Incidences input form. 

3. Enter the member number in the first text box and press the Enter key. 

When this form is opened, the first text box has the input focus and contains the number 

"1". When creating a new model, it is recommended that you enter member incidences 

starting from the first member to the last member by pressing the Enter key to skip this 

text box. When modifying an existing model, the text in the member number edit box can 

be changed as needed. 

4. Enter the start joint number in the second text box and press the Enter key. 

5. Enter the end joint number in the third text box. 

6. Click on the Update button or press the Alt key in combination with the U key to 

update data. 

7. Repeat Steps 3 to 6 until all member incidences have been entered. 

8. Click on the OK button or Press the Alt key in combination with the 0 key to close this 

form. 

A.3.S.2 MEMBER INCIDENCES AUTO-GENERATION 

1. Select the Member menu from the main form to display the items in this pull down 

menu. 

2. Select the Incidences menu item to open the Member Incidences input form. 
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3. Select the Auto menu item to open the Member Incidences Auto-Generation form. 

4. Enter the merrlber number of the first member in the group of merrlbers in the first text 

box and press the Enter key. 

S. Enter the member number of the last member in the group of members in the second 

text box and press the Enter key. 

6. Enter the increment in the member number in the third text box and press the Enter key. 

7. Enter the start joint number of the first member in the group in the fourth text box and 

press the Enter key. 

8. Enter the end joint number of the first member in the group in the fifth text box and 

press the Enter key. 

9. Enter the value for the increment in member incidences in the sixth text box. 

10. Click on the Update button to update the data. 

11. Repeat Steps 4 to 9 to generate member incidences for the members in another group. 

12. Click on the OK button to return to the Merrlber Incidences input form. 

A.3.6 MEMBER PROPERTIES INPUT 

A.3.6.1 MATERIAL PROPERTIES INPUT 

1. Select the Member menu from the main form to display the items in this pull down 

menu. 

2. Select the Properties menu item to display the Properties sub menu. 

3. Select the Material menu item to open the Material Properties input form. 

4. Enter the member number of the first member in the group of merrlbers in the first text 

box and press the Enter key. 

S. Enter the member number of the last member in the group of members in the second 

text box and press the Enter key. 

6. Select one of the radio buttons to choose the material type from the following choices: 

steel, concrete or user-defined. 
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If steel is selected: 

The modulus of elasticity, shear modulus and coefficient of thermal expanSIon are 

displayed in the corresponding text boxes after this operation. 

If concrete is selected: 

6.1 Enter the compressive strength of the concrete in the text box and press the Enter key. 

The modulus of elasticity, shear modulus and coefficient of thermal expansion are 

computed and displayed in the corresponding text boxes after this operation. 

Ifuser-defined is selected: 

6.1 Enter the modulus of elasticity in the corresponding text box and press the Enter key. 

6.2 Enter the shear modulus in the corresponding text box and press the Enter key. 

6.3 Enter the coefficient of thermal expansion in the corresponding text box and press the 

Enter key. 

7. Click on the Update button or press the Alt key in combination with the U key to 

update the data. 

8. Repeat Steps 4 to 7 to enter material properties for all members of the structure. 

9. Click on the OK button or press the Alt key in combination with the 0 key to close this 

form. 

Selecting Single mode in the Option menu allows you to enter the material properties for 

an individual member. In this case, simply enter the member nurrlber in Step 4 and skip 

Step 5. 

A.3.6.2 GEOMETRIC PROPERTIES INPUT 

1. Select the Member menu from the main form to display the items in this pull down 

menu. 

2. Select the Properties menu item to display the Properties sub menu. 

3. Select the Geometry menu item to open the Geometric Properties input form. 
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4. Enter the member number of the first member in the group of members in the first text 

box and press the Enter key. 

5. Enter the member number of the last member in the group of members in the second 

text box and press the Enter key. 

6. Select the radio button corresponding to the following choices: AISC shape assignment, 

or User Defined. Note that if the SI system of units is used, then the radio button for 

AISC shape assignment is grayed. 

If AISC is selected: 

7. 1 Select the desired shape from the list of shapes that appear in the list box. 

7.2 Select the desired section by moving the mouse cursor over the item in the combo box 

and clicking the left mouse button or simply typing in the desired section in the edit field 

of the combo box and pressing the Enter key. A message box appears on the screen to 

display an error message if the section entered is not included in the AISC shape data 

base. 

The geometric properties of the section are displayed in the corresponding text boxes after 

this operation. 

If User Defined is selected: 

7.1 Enter the cross-sectional area in the corresponding text box and press the Enter key. 

7.2 Enter the moment ( s) of inertia according to the type of structure. 

8. Click on the Update button or press the Alt key in combination with the U key to 

update the data. 

9. Repeat Steps 4 to 8 to enter the geometric properties for the remaining members. 

10. Click on the OK button or press the Alt key in combination with the 0 key to close 

this form. 

If the Single mode option was selected, simply enter the member number in Step 4 and 

skip Step 5. 
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A.3.7 BETA ANGLE INPUT 

1. Select the Member menu from the main form to display the items in this pull down 

menu. 

2. Select the Beta Angle menu item from the pull down menu to open the Beta Angle 

input form. 

3. Enter the member number in the first text box and press the Enter key. 

4. Enter the beta angle in the second text box. 

5. Click on the Update button or press the Alt key in combination with the U key to 

update the data. 

6. Repeat Steps 3 to 5 to enter the beta angle for the rest of the members. 

Note that the default value of the beta angle is zero, so it is only necessary to enter the 

beta angle for those members for which the beta angle is not zero. 

7. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Beta Angle input form and return to the main form. 

A.3.8 MEMBER RELEASES INPUT 

1. Select the Member menu from the main form to display the items in this pull down 

menu. 

2. Select the Member Releases menu item from the pull down menu to open the Member 

Releases input form. 

3. Enter the member number in the text box. 

4. Select the appropriate check boxes to enter member releases. 

5. Click on the Update button or press the Alt key in combination with the U key to 

update the data. 

6. Repeat Steps 3 to 5 to enter all the member releases in the model. 

7. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Member Releases input form and return to the main form. 
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A.3.9 JOINT COORDINATES INPUT 

1. Select the Joint menu from the main form to display the items in this pull down menu. 

2. Select the Joint Coordinates menu item from the pull down menu to open the Joint 

Coordinates input form. 

3. Enter the joint number in the first text box and press the Enter key. 

4. Enter the global X coordinate in the second text box and press the Enter key. 

S. Enter the global Y coordinate in the third text box and press the Enter key. 

6. Enter the global Z coordinate in the fourth text box. 

Note that the global Z coordinate is only required for the space truss and the space frame 

models. 

7. Click on the Update button or press the Alt key in combination with the U key to 

update the data. 

8. Repeat Steps 3 to 7 to enter the joint coordinates for the remaining joints. 

9. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Joint Coordinates input form and return to the main form. 

A.3.10 AUTO-GENERATION OF JOINT COORDINATES 

1. Select the Joint menu from the main form to display the items in this pull down menu. 

2. Select the Joint Coordinates menu item from the pull down menu to open the Joint 

Coordinates input form. 

3. Select the Auto menu item to open the joint coordinates auto-generation form. 

4. Enter the joint number of the first joint in the series in the first text box and press the 

Enter key. 

S. Enter the joint number of the last joint in the series in the second text box and press the 

Enter key. 

6. Enter the value for the increment in the joint number in the third text box and press the 

Enter key. 
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7. Enter the coordinates for the first joint in the corresponding text box and press the 

Enter key. 

8. Enter the value for the increments in the coordinates in the corresponding text boxes 

and press the Enter key. 

9. Click on the Update button or press the Alt key in combination with the U key to 

update the data. 

10. Repeat Steps 4 to 9 to generate the joint coordinates for the remaining joints. 

11. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Joint Coordinate Auto-Generation form and return to the Joint Coordinates input form. 

A.3 .11 JOINT CONSTRAINTS INPUT 

1. Select the Joint menu from the main form to display the items in this pull down menu. 

2. Select the Joint Constraints menu item from the pull down menu to open the Joint 

Constraints input form. 

3. Enter the joint number of the constrained joint and press the Enter key. 

4. Select the appropriate radio button to select joint constraints. 

Note that four separate input forms are used to input joint constraints because of the 

different structure types. The check boxes under the Other (user defined) option are 

enabled automatically after the Other (user defined) option has been selected. 

5. Click on the Update button or press the Alt key in combination with the U key to 

update the data. 

6. Repeat Steps 3 to 5 to enter the remaining joint constraints. 

7. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Joint Constraints input form and return to the main form. 
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A.3.12LOADS 

A.3.12.1 LOAD CASE DESCRIPTIONS 

I. Select the Loads menu from the main form to display the items in this pull down menu. 

2. Select the Load Case Descriptions menu item from the pull down menu to open the 

Load Case Descriptions input form. 

3. Enter the load case number in the first text box and press the Enter key. 

4. Select from the items in the list box to enter a preset load case description by double 

clicking the left mouse button or enter a load case description in the second text box and 

press the Enter key. 

5. Click on the Update button or press the Alt key in combination with the U key to 

update the data. 

6. Repeat Steps 3 to 5 to enter all load case descriptions. 

7. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Load Case Descriptions input form and return to the main form. 

A.3.12.2 LOAD COMBINATIONS 

I. Select the Loads menu from the main form to display the items in this pull down menu. 

2. Select the Load Combinations menu item from the pull down menu to open the Load 

Combinations input form. 

3. Enter the load combination number in the first text box and press the Enter key. 

4. Select the load case from the list box containing load case descriptions. 

5. Enter the corresponding load factor for this load case in the text box to the right of the 

load description and press the Enter key. 

6. Repeat Steps 4 to 5 to enter all load cases and the corresponding load factors. 

7. Click on the Update button or press the Alt key in combination with the U key to 

update the data. 
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8. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Load Combinations input form and return to the main form. 

When editing an existing data file in which the load case descriptions have been changed, 

the previous load cases and the corresponding load factors appear in the load 

combinations when the Load Combinations input form is opened. In this case, click on the 

Delete button in the Load Combinations input form to delete the previous load cases and 

the corresponding load factors. To delete a load case from a load combination, simply 

select the load case from the list box and click on the Delete button. 

A.3.12.3 JOINT LOADS 

1. Select the Loads menu from the main form to display the items in this pull down menu. 

2. Select the Joint Loads menu item from the pull down menu to open the Joint Loads 

input form. 

3. Enter the load case number in the first text box and press the Enter key. 

Load case numbers begin from 1 to the total number of load cases in the model. Use the 

NextlPrev. Load Case button to increase or decrease the load case number or select the 

text box to enter a load case number. 

4. Enter the joint load number in the second text box and press the Enter key. 

The joint load number is the number of joint loads in each load case. It is generated 

automatically. This text box can be skipped by pressing the Enter key. 

S. Enter the joint number of the joint at which the load is applied in the third text box and 

press the Enter key. 

6. Enter the magnitude of joint load (force or moment) in the fourth text box. 

7. Select the radio button corresponding to the type of joint load (force or moment). 

8. Select the radio button corresponding to the direction in which the load is applied 

(global X, Y or Z direction). 

78 



U serfs Guide 

9. Click on the Update button or press the Alt key in combination with U key to update 

the data. 

10. Repeat Steps 4 to 9 to enter all joint loads for this load case. 

11. Click on the Next Load Case button or press the Alt key in combination with the E 

key to proceed to the next load case. 

12. Repeat Steps 4 to 11 to enter joint loads for all load cases. 

13. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Joint Loads input form and return to the main form. 

A.3.12.4 MEMBER LOADS 

1. Select the Loads menu from the main form to display the items in this pull down menu. 

2. Select the Member Loads menu item from the pull down menu to display the items in 

the Member Loads sub menu. 

3. Selecting the menu item corresponding to the type of member load: Concentrated, 

Uniform, Linear or Temperature Change. 

Since the input procedures for the input forms for all member loads are similar, only the 

input form for linear load is described below. 

4. Enter the load case number in the first text box and press the Enter key. 

5. Enter the member number in the second text box and press the Enter key. 

6. Enter the magnitude wI in the third text box and press the Enter key. 

7. Enter the distance d 1 in the fourth text box and press the Enter key. 

8. Enter the magnitude w2 in the fifth text box and press the Enter key. 

9. Enter the distance d2 in the sixth text box. 

10. Select the radio button corresponding to the direction of load. 

11. Click on the Update button or press the Alt key in combination with the U key to 

update the data. 

12. Repeat Steps 4 to 12 to enter linear loads for all load cases. 
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13. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Linear Load input form and return to the main form. 

A.3.12.5 PRESCRIBED DISPLACEMENTS 

1. Select the Load menu from the main form to display the items in this pull down menu. 

2. Select the Prescribed Displacements menu item from the pull down menu to open the 

Prescribed Displacements input form. 

3. Enter the load case number in the first text box and press the Enter key. 

Load case numbers begin from 1 to the total number of load cases in the modeL Use the 

NextIPrev. Load Case button to increase or decrease the load case number or select the 

text box to enter a load case number. 

4. Enter the prescribed displacement number in the second text box and press the Enter 

key. 

The prescribed displacement number is the number of prescribed displacements in each 

load case. It is generated automatically. This text box can be skipped by pressing the Enter 

key. 

5. Enter the joint number of the joint subjected to the prescribed displacement in the third 

text box and press the Enter key. 

6. Enter the magnitude of the prescribed displacement in the fourth text box. 

7. Select the radio button corresponding to the type of prescribed displacement 

(translation or rotation). 

8. Select the radio button corresponding to the direction of the prescribed displacement 

(global X, Y or Z direction). 

9. Click on the Update button or press the Alt key in combination with U key to update 

the data. 

10. Repeat Steps 4 to 9 to enter all joint load for this load case. 
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11. Click on the Next Load Case button or press the Alt key in combination with the E 

key to proceed to the next load case. 

12. Repeat Steps 4 to 11 to enter prescribed displacements for all remaining load cases. 

13. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Prescribed Displacements input form and return to the main form. 

A.3.13 DATA REVIEW 

A.3.t3.t NUMERICAL DATA REVIEW 

1. Select the View menu from the main form to display the items in this pull down menu. 

2. Select the Data menu item from the pull down menu to open the Data Review window. 

3. Select the type of information to be reviewed, for example, joint coordinates, joint 

loads, member incidences, etc. 

4. Click on the More button or press the Alt key in combination with the M key to display 

more data. 

If there is more data to be reviewed, a message is displayed on the screen to remind the 

user to click the More button. 

5. Repeat Steps 3 to 4 to view other data. 

6. Click on the OK button or press the Alt key in combination with the 0 key to close the 

Data Review window and return to the main form. 

The Data Review form can also be opened by clicking the List button in any of the data 

entry forms. 

A.3.13.2 GRAPHICS 

A.3.13.2.1 DISPLAY 

1. Select the View menu from the main form to display the items in this pull down menu. 
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2. Select the Graphics menu item from the pull down menu to open the Graphics Output 

window. 

3. Select the Structure menu to display the structure mesh. 

Note that the structure mesh must be displayed first. 

When the structure mesh is displayed on the screen, the joint numbers and member 

numbers can be displayed by clicking the corresponding command buttons and the loads 

can be displayed by selecting the corresponding menu items. The menu items will be 

grayed if there are no loads for the given load case. Use the Next and Prevo Load Case 

buttons to select the load cases. 

A.3.13.2.2 CLEARING THE CURRENT GRAPHICS DISPLAY 

The currently displayed graphical information can be cleared in several ways. The menu 

items and command buttons which are used to display the information also serve as toggle 

switches for turning on/off the display. Therefore, each type of load can be cleared by 

clicking the corresponding menu item a second time. The member numbers and joint 

numbers can also be cleared by clicking the corresponding command buttons a second 

time. A check mark on the left side of the menu item for a load indicates that the load is 

currently displayed. The user can also click the Structure menu to clear all graphical 

information currently displayed on the screen and redraw the structure mesh. The 

Graphics Output form also provides a Clear button to clear the display. 

The Graphics Output form can be closed by clicking on the OK button or pressing the Alt 

key in combination with the 0 key. 

A.3.14 SAVING THE STRUCTURAL MODEL 

To save the current structural data: 

1. Select the File menu from the main form to display the items in this pull down menu. 
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2. Select the Save menu item to save the file. 

The Save function saves an existing file only. If the file is a new file and the Save menu 

item is select, the Save As... form will be opened. See Section A.3 .15 for more 

information. 

A.3.IS SAVE AS ... 

To save the current data in a different file: 

1. Select the File menu from the main form to display the items in this pull down menu. 

2. Select the Save As ... menu item to open the Save As ... form. 

3. Click on the item in the drive list box to select the drive name. 

4. Click on the item in the directory list box to select the directory name. 

5. Type the file name in the File Name text box and press the Enter key or click on the OK 

button. 

You can also type the file path in the text box such as, for example, "a:\test\testI.dat" and 

then press the Enter key or click on the OK button. 

The Save As function is used only if the file is a new file or the file is to be saved under a 

different name. 

A.3.I6EXIT 

1. Select the File menu from the main form to display the items in this pull down menu. 

2. Select the Exit menu item in the pull down menu to exit the preprocessor. 

Before exiting, the preprocessor will remind you to save the file if a file has not been saved 

or if an existing file has been changed. 
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A.3.17HELP 

Help on the preprocessor is available from the Help menu on the menu bar in the main 

form. To obtain help: 

I. Select the Help menu from the main form to display the items in this pull down menu. 

2. Select the Index menu item to open the Help form. 

3. Click on the arrow on the right side of the combo box to open the list of help topics. 

4. Click on the topic in the combo list or type in the name of item in the edit field of the 

combo box and press the Enter key. 

5. Use the vertical scroll bar to review the help text. 

6. Repeat Steps 3 to 5 to obtain help on another topic. 

7. Click on the OK button or press the Alt in combination with the 0 key to close the Help 

window and return to the main form. 

Help for individual forms can be obtained by clicking the Help button provided in the 

form. In this case, the combo box is not displayed and only the information regarding the 

corresponding form is provided. When the Help form is closed, the previous form is 

activated automatically. 
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APPENDIXB 

EXAMPLES 

In this appendix, examples of date files for plane truss, plane frame, space truss and space 

frame structures under various kinds of loads are presented. In addition, the format of the 

output data file is explained through the space frame example. 

B.t SPACE FRAME 

The structure is shown in Figure B.t. The output data file text and explanation are 

described below: 

Selfwei!tJt w=1 knkn 

1 

5 
3 

1 
3 

1 2 

Fig B.t Space frame structure (The member loads shown are for load case 2) 

Data File Syntax 

EXAMPLE PROBLEM NO.1 

TYPE SPACEFRAME 

UNIT SYSTEM SI 

Explanations 

Project description 

Structure type 

keyword for units 

Note 

Any text, limit to one line 

Other keywords: 

SPACE TRUSS, PLANE 

TRUSS, PLANE FRAME. 

Other keyword: US 
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NUMBER OF JOINTS 8 

NUMBER OF MEMBERS 8 

NUMBER OF SUPPORTS 4 

NUMBER OF LOADINGS 4 

JOINT COORDINATES 

1 0 0 0 S 

2 10 0 0 S 

3 10 0 -10 S 

4 0 0 -10 S 

5 0 10 0 

6 10 10 0 

7 10 10 -10 

8 0 10 -10 

MEMBER INCIDENCES 

1 1 5 

2 2 6 

3 3 7 

4 4 8 

5 5 6 

6 6 7 

7 7 8 

8 5 8 

JOINT RELEASE* 

(Note that there is no joint release in this 

example, the keywords here and below are for 

demonstration purpose only) 

Total number of 

joints 

Total number of 

members 

Total number of 

supporting joints 

The total number of joints 

cannot be greater than 100 or 

less than O. 

The total number of members 

cannot be greater than 100 or 

less than O. 

This number is determined by 

the joint constraints entered. 

Total number of load The total number of load cases 

cases cannot be greater than 10 or 

less than O. 

Keyword for the 

processor program 

The order of the keywords that 

describe the geometry of the 

model is random. 

Joint coordinates for "3" is the joint number, "10", 

all joints "0" and "-10" are the joint 

The syntax for the coordinates in the global X, Y 

line with Italian font and Z directions. ItS' means 

are explained in the this joint is a support. 

Note. 

Keyword for the 

processor program 

Member incidences "1" is the member number, "1" 

for all members and "5" are the joint numbers 

The syntax for the of the start joint and end joint 

line with Italian font respectively. 

are explained in the 

Note. 

Keywords for joint 

release. 
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1 FORCE X 

MEMBER RELEASE* 

(Note that there is no member release in this 

example, the keywords here and below are for 

demonstration purpose only) 

2 START MOMENT Z 

MEMBER PROPERTIES PRISMATIG 

1 AX IX IY IZ BETA 1.40.228.116 0 

2 AX IX IY IZ BETA 1.4 0.228 .116 0 

3 AX IX IY IZ BETA 1.40.228 .116 0 

4 AX IX IY IZ BETA 1.40.228 .116 0 

5 AX IX IY IZ BETA 5.2 0 2.92 1.73 0 

6 AX IX IY IZ BETA 5.2 0 2.92 1.73 0 

7 AX IX IY IZ BETA 5.2 0 2.92 1.73 0 

8 AX IX IY IZ BETA 5.202.92 1.73 0 

CaNST ANTS E 200 ALL 

Description of joint 

release. 

Keywords for 

member release. 

Description of 

member release. 

Keyword for the 

processor program 

" 1" is the joint number, 

"FORCE X" is the direction of 

the joint release. Other 

keywords are "FORCE Y", 

"FORCE Z", "MOMENT X", 

"MOMENT Y" and 

"MOMENTZ". 

"2" is the member number, 

"ST ART" specifies the location 

of the release. Other keywords 

are "END". "MOMENT Z" is 

the direction of member 

release. Other syntax are the 

same as joint release. 

Geometric properties " 1" is the member number, 

of members. "1.4", "0", ".228", ".116" and 

The keywords in "0" are the cross-sectional area, 

Italian font are moment of inertia about the 

explained in the local x, y and z axes and beta 

Note. angle respectively. 

Modulus of elasticity The keywords for assigning the 

This statement modulus of elasticity to 

assigns 200 Gpa ksi individual members are 

as the modulus of "CONSTANTS E 200 N1 TO 

elasticity for all N2", where N1 and N2 are the 

members. start and end member numbers 

of the group. 
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CONSTANTS G 77 ALL 

CONSTANTS ALPHA 0 ALL 

LOAD COMBINATION 1 

0.7 2 1.2 3 

LOAD COMBINATION 2 

0.8 2 1.3 3 

LOADING 1 WIND LOAD 

JOINT LOADS 

5FORCEX 10 

8FORCEX 10 

LOADING 2 DEAD LOAD 

MEMBER LOADS 

Shear modulus 

This statement 

assigns 77 Gpa as 

the shear modulus 

for all members. 

Coefficient of 

thermal expansion 

This statement 

assigns 0 as the 

coefficient of 

thermal expansion 

for all members. 

Keywords for the 

processor program .. 

Load combinations 

The keywords in 

Italian font are 

explained in the 

Note. 

Load case 

description 

Keyword for joint 

loads 

Description of joint 

load. The keywords 

in Italian font are 

explained in the 

Note. 

Keyword for member 

load 

The keywords for assigning the 

shear modulus to individual 

members are "CONSTANTS G 

77Nl TON2". 

The keywords for assigning the 

coefficient to individual 

members are "CONSTANTS 

ALPHA 0.0000065 Nl TO 

N2". 

o. 7" is the load factor for load 

case "1", "1.2" is the load 

factor for load case "2". 

"5" is the joint number at 

which the load is acting. 

"FORCE X'I is the direction of 

the joint load. Other directions 

can be "FORCE Y", "FORCE 

ZIt, "MOMENT X", 

"MOMENT Y" and 

"MOMENT Z". "10" is the 

magnitude of the joint load. 
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5 FORCE Y UNIFORM-1 

6 FORCE Y UNIFORM I 

7 FORCE Y UNIFORM I 

8 FORCE Y UNIFORM I 

LOADING 3 POINT LOAD 

MEMBER LOADS 

5 FORCE Y CONCENTRATED -5 5 

LOADING 4 SUPPORT DIS 

SUPPORT DISPLACEMENTS 

Description of 

member load. The 

syntax for the line 

with Italian font is 

explained in the 

Note. 

Load case 

description 

Load case 

description 

Keywords for the 

prescribed 

displacement 

"5" is the member number of 

which the member load on 

which the load is acting. 

"FORCE )11' is the direction of 

the member load. Other 

directions are "FORCE X" and 

"FORCEY". 

"UNIFORM' is the type of 

member load. Other types are 

"CONCENTRATED", 

"LINEAR" and 

"TEMPERATURE". ".2" is the 

magnitude of the member load. 

The keywords for the linear 

load are "N FORCE Y WI DI 

W2 D2", where N is the 

member number, w I and w2 

are the magnitude of the load 

at the left and right side, dl 

and d2 are the distance from 

the start jointto the start and 

end of the load. The keywords 

for temperature change are "N 

TEMPERA TORE T", where T 

is the amount of temperature 

change. 
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1 FORCEX-.l 

SOLVE 

B.2 PLANE TRUSS 

Description of 

prescribed 

displacement 

Keyword indicates 

the end of the data 

file 

keywords are the same as joint 

load. "FORCE X" means a 

translation in the global X 

direction and "MOMENT X" 

means a rotation about the 

global X direction. 

This example shows a plane truss model subjected to joint loads in two directions. The 

structure is shown in Figure B. 2. 

p=10 kips 

Fig B.2 Plane truss structure (The joint loads shown are for load case 1) 

EXAMPLE PROBLEM NO.2 

TYPE PLANE TRUSS 

UNIT SYSTEM SI 

NUMBER OF JOINTS 5 

NUMBER OF MEMBERS 7 

NUMBER OF SUPPORTS 2 

NUMBER OF LOADINGS 2 

JOINT COORDINATES 

1 o o S 
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2 5 0 

3 10 0 

4 2.5 5 

5 7.5 4 

MEMBER INCIDENCES 

1 1 2 

2 2 3 

3 1 4 

4 2 4 

5 2 5 

635 

745 

S 

MEMBER PROPERTIES PRISMATIC 

1 AX .0086 

2 AX .0086 

3 AX .00432 

4 AX .00432 

5 AX .00432 

6 AX .00432 

7 AX .00246 

CaNST ANTS E 200 ALL 

CONSTANTS ALPHA 0 ALL 

LOADING 1 

JOINT LOADS 

4 FORCE Y -10 

5 FORCE Y -10 

LOADING 2 

JOINT LOADS 

4 FORCE X 10 

SOLVE 

B.3 PLANE FRAME 

This example shows a plane frame model. The structure is shown in Figure B. 3. 
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Fig B. 3 Plane frame structure 

EXAMPLE PROBLEM NO.3 

TYPE PLANE FRAME 

UNIT SYSTEM US 

NUMBER OF JOINTS 6 

NUMBER OF MEMBERS 6 

NUMBER OF SUPPORTS 2 

NUMBER OF LOADINGS 1 

JOINT COORDINATES 

1 0 0 S 

2 0 0 S 

3 0 5 

4 10 5 

5 0 0 

6 10 10 

MEMBER INCIDENCES 

1 1 3 

2 2 4 

3 3 5 

4 4 6 

5 5 6 

6 3 4 

MEMBER PROPERTIES PRISMATIC 
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1 AXIZ 10 100 

2 AX IZ 10 100 

3 AXIZ 10 100 

4 AX IZ 10 100 

5 AXIZ 10 100 

6 AX IZ 10 100 

CONSTANTS E 29000 ALL 

CONSTANTS ALPHA .0000065 ALL 

LOADING 1 DEAD LOAD 

:MEMBER LOADS 

6 FORCE Y UNIFORM -10 

5 FORCE Y LINEAR -10 0 0 10 

SOLVE 

B.4 SPACE TRUSS 

This example shows a space truss model. The structure is shown in Figure B.4. 

p=10 kips 

p=10 kips 

1 

Fig B.4 Space truss structure 

EXAMPLE PROBLEM NO.4 

TYPE SPACE TRUSS 

UNIT SYSTEM US 

NUMBER OF JOINTS 8 

NUMBEROF:MEMBERS 8 

7 7 

3 
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NUMBER OF SUPPORTS 4 

NUMBER OF LOADINGS 1 

JOINT COORDINATES 

1 0 0 0 S 

2 10 0 0 S 

3 10 0 -10 S 

4 0 0 -10 S 

5 0 10 0 

6 10 10 0 

7 10 10 -10 

8 0 10 -10 

MEMBER INCIDENCES 

1 1 5 

2 1 6 

3 3 7 

4 4 8 

5 5 6 

6 6 7 

7 7 8 

8 5 8 

MEMBER PROPERTIES PRISMATIC 

lAX4.16 

2 AX4.16 

3 AX4.16 

4AX4.16 

5 AX4.16 

6AX4.16 

7 AX4.16 

8 AX4.16 

CONST ANTS E 29000 ALL 

CONSTANTS ALPHA .0000065 ALL 

LOADING 1 WIND LOAD 

JOINT LOADS 

5 FORCE X 10 

8 FORCE X 10 

SOLVE 
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